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Améliorer lI'expérience utilisateur
avec Agile Business Suite

Par Thangathen Ponnusamy, responsable produit
mondial, Agile Business Suite et Enterprise
Application Environment, Unisys

Les technologies liées a I'expérience utilisateur et
a l'interface utilisateur (IU) offrent de nouvelles
possibilités pour faire participer vos clients, vos
partenaires et vos employés.

AN Cependant, pour nouer des liens avec ces
dlfferentes parties prenantes, il faut encore trop souvent trouver un équilibre entre
deux facteurs essentiels, mais conflictuels. D‘une part, les processus métier, et
les applications d‘entreprise qui les comprennent, deviennent de plus en plus
complexes a mesure qu'ils inteégrent de nouveaux projets et que les besoins des
clients s‘accroissent. Par ailleurs, la réussite finale de ces applications dépend
généralement de leur simplicité d'utilisation et de leur convivialité.

Les utilisateurs recherchent un design élégant et épuré. L'aspect visuel et les
fonctionnalités doivent étre parfaitement intégrés. Seules les informations les
plus utiles et les plus pertinentes doivent étre accessibles a tout moment.
Linterface utilisateur doit respecter toutes les exigences fonctionnelles
applicables tout en assurant la productivité des utilisateurs, sans qu’il soit
nécessaire de suivre une formation intensive et longue. Elle doit étre adaptée
aux connaissances de chaque utilisateur, ainsi qu‘au cadre dans lequel il
souhaite travailler. Et dans la plupart des cas, son délai de mise sur le marché
doit étre le plus court possible.

Grace a Agile Business Suite (AB Suite®), vous pouvez vous servir d'un large
éventail d‘outils pour créer l'interface utilisateur dont vous avez besoin. Ainsi, vous
pouvez éviter les contraintes de temps, ne plus avoir besoin de compétences
spécialisées et mettre plus rapidement en ceuvre de nouvelles fonctionnalités.

Client Tools

AB Suite Client Tools est une suite logicielle qui offre toute une gamme
d‘interfaces utilisateur pour les applications AB Suite. Elle vous permet de
créer un vaste choix d‘interfaces utilisateur pour les ordinateurs, le Web et les
appareils mobiles, ainsi que des applications orientées service. >>

Vous n’étes pas encore abonné a Developing Agility ? Ne manquez pas notre
prochain numéro : inscrivez-vous des aujourd’hui.
Pour consulter les précédents numéros de Developing Agility, parcourez les archives.
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Comme les solutions créées par Client Tools fournissent
des résultats prévisibles, et que le code, la stabilité, les
performances et I‘évolutivité ont été testés, vous pourrez
les commercialiser plus rapidement. En assurant la
richesse de l'expérience utilisateur, Client Tools simplifie la
prise en main des applications et facilite la formation des
utilisateurs d'EAE et d'AB Suite, tout en augmentant leur
productivité et en favorisant une plus grande flexibilité.

Vous pouvez vous servir des générateurs standard

ou développer un générateur personnalisé a l‘aide du
Customization Kit (kit de personnalisation) du logiciel.

Le Customization Kit vous guide dans I‘élaboration d‘un
générateur ou dans le choix d'un générateur fourni par un
tiers. Quelle que soit la méthode employée, vous pouvez
créer une interface utilisateur qui respecte les définitions
de votre modele AB Suite, tient compte de vos besoins

et se compile a 'aide de la technologie de votre choix. Et
comme Client Tools est commun a EAE et a AB Suite, il est
beaucoup plus facile de modemiser les interfaces EAE pour
migrer vers AB Suite, car l'interface utilisateur est la méme.

ClearPath Forward ePortal

Vous pouvez transformer les interfaces des applications
AB Suite existantes a l‘aide de I'environnement de
modernisation de type pointer-cliquer qui se trouve
dans ClearPath Forward® ePortal. Avec ePortal Developer,
vous pouvez créer une solution compléte et préparer
son déploiement, sans perdre de vue l'essentiel : une
présentation optimale de I'application auprés de vos
utilisateurs. Et comme toute la solution est automatisée,
vous pouvez accélérer et réduire les colts de mise sur
le marché de votre nouvelle application, sans nécessiter
de compétences spécialisées.
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En associant ces fonctionnalités au nouveau service
innovant de développement d‘applications mobiles
hybrides Unisys, vous pouvez enrichir encore
davantage vos applications en les combinant avec les
fonctionnalités natives des services qui se trouvent sur
les appareils mobiles, comme le GPS, la lecture des
codes barres, ainsi que la capture photo et vidéo.

Client Framework

Loutil Client Framework d‘Agile Business Suite vous
permet de développer des interfaces utilisateur

de pointe en utilisant la technologie de votre choix.
Vous controlez parfaitement l‘expérience utilisateur

afin d'obtenir plus facilement des résultats de meilleure
qualité pour les personnes qui manipulent tous les
jours vos applications. Vous pouvez également dissocier
les composants de l'interface utilisateur de la logique
métier et de la base de données de l‘application.

Ainsi, vos concepteurs d‘interface utilisateur peuvent

se concentrer sur la richesse de I'expérience utilisateur,
tandis que vos développeurs AB Suite peuvent veiller a
ce que la logique métier et les définitions des interfaces
respectent les exigences les plus récentes.

En tant qu‘élément pris en charge par

I'AB Suite Runtime pour Microsoft® Windows®, le

Client Framework permet d'utiliser la technologie courante
Windows Presentation Foundation (WPF) pour créer

des interfaces utilisateur basées sur les modeles de
données que vous créez. En outre, Client Framework
fonctionne avec des outils tels que ASP.Net MVC 5, ASP.
Net Web API, HTML5, JavaScript, CSS et JQuery.

Améliorer votre expérience client

AB Suite met a votre disposition un certain nombre

de technologies d‘interface utilisateur dont vous

pouvez facilement vous servir pour améliorer I'expérience
utilisateur et la participation des clients externes

et internes. Si vous souhaitez en savoir plus sur les
fonctionnalités décrites dans cet article ou les découvrir
plus dans le détail dans un projet pilote, nous vous
invitons a nous contacter a |‘adresse ABSuite@unisys.com.
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Résumé du test béta 4 d‘AB Suite 7.0

Alors que la sortie de la version 7.0 d‘Agile
Business Suite prévue pour le deuxieme trimestre
2019 approche a grands pas, nous avons invité
les utilisateurs d’AB Suite a participer a un certain
nombre de tests béta.

En fait, nous venons de terminer le test béta 4 d‘AB Suite 7.0.
Ce test est toujours trés intéressant, car la version béta 4
comprend généralement la plupart des fonctionnalités qui se
retrouveront dans la version finale du logiciel. Voici quelques-
unes des nouvelles fonctionnalités clés explorées par les
utilisateurs lors du test béta 4.

Modes AB Suite

Chaque modele AB Suite est configurable de facon a utiliser
I‘un des différents modes de fonctionnement du produit.

Ces modes de fonctionnement uniques mettent en avant des
fonctionnalités particulieres. lls se sont étoffés au cours des
deux dernieres versions d'’AB Suite et continuent d‘évoluer
dans AB Suite 7.0.

En fonction des commentaires que nous avons recus suite
aux précédents tests béta, les conventions de dénomination
des modes de fonctionnement du produit ont été révisées
avant le test béta 4. Voici les nouveaux noms de mode et les
fonctionnalités de chacun d‘eux :

e Standard (Standard) : Fonctionnalités de base orientées
objet. Disponible sur les environnements d‘exécution de
ClearPath® MCP et de Windows.

e Advanced (Avancé) : Fonctionnalités polymorphes avancées.
Disponible sur MCP et Windows, bien que XML ne soit pas
pris en charge par I'environnement d‘exécution de MCP.

e User Experience (Expérience utilisateur) : Fonctionnalités
de l'interface utilisateur de I‘outil Client Framework d‘Agile
Business Suite. Disponible sous Windows uniquement.

Developing Agility | Octobre 2018

Modele AB Suite

Le modele AB Suite a remanié la classe lors du test béta 4
pour ne plus représenter que les types complexes. Comme
décrit dans un précédent test béta, les types primitifs sont
définis a l'aide du nouvel objet primitif. Parmi les autres
modifications importantes apportées au cours du test béta 4,
mentionnons :

e Les fichiers d‘extraction sont définis a I‘aide du nouveau
stéréotype « File » (Fichier), au lieu d'hériter de GLB.File.

e la logique de contrdle de la valeur des attributs
n‘est disponible que pour les attributs Ispec dans
la présentation.

e les regles et la validation du modele concernant l‘endroit
ou les classes internes peuvent étre instanciées ont été
améliorées, ce qui facilite leur réutilisation.

Outil de débogage AB Suite

Les testeurs de la version béta 4 ont pu utiliser la nouvelle
fonctionnalité de configuration automatique de l‘outil

de débogage (Debugger) qui renseigne les propriétés

de configuration minimale avec les valeurs par défaut
lorsqu‘une session de débogage est lancée. Aprés avoir lancé
leurs sessions de débogage, les testeurs ont pu modifier les
propriétés par défaut dans la boite de dialogue « Configuration
Properties » (Propriétés de configuration) du modele.

Les testeurs ont également pu essayer les nouvelles fenétres

« Watch » (Espion), « Local » (Local) et « Auto » (Auto) qui

ont été enrichies par des fonctionnalités complétes d‘édition,
ainsi que par la possibilité de surveiller chaque cellule dans
un tableau. Les grands tableaux et les groupes en une seule
chaine de caractéres ont été déplacés dans la nouvelle fenétre
« Immediate » (Immédiat) pour les afficher a la demande.

Les testeurs ont pu constater que cette modification a
considérablement amélioré les performances. >>
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Outil de débogage et ATT d'AB Suite

Les testeurs ont pu lire les tests enregistrés avec [‘outil
de débogage pour les projets de type « user experience »
(expérience utilisateur).

Compilations par ligne de commande AB Suite

Lutilitaire en ligne de commande « Builder.exe » a été
retiré depuis le test béta 4. Toutes les compilations
depuis la ligne de commande s‘effectuent maintenant
a partir de MS Build. En outre, les testeurs ont pu
également compiler et déployer des systemes pour
l‘outil de débogage en utilisant MS Build. Pour l‘activer,
les parametres utilisateur de 'outil de débogage sont
maintenant stockés dans un fichier « .user » qui se
trouve dans le répertoire du projet.

AB Suite sur Windows

Le test béta 4 incluait la prise en charge en parallele
d'AB Suite sur I'environnement d‘exécution de Windows.
Les utilisateurs ont ainsi pu installer la version 7.0 en
méme temps que d‘autres versions d'AB Suite sur la
méme machine, sans aucun conflit.
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Business Integrator

Comme les fichiers de modeles créés par

Business Integrator sont maintenant compatibles avec
les modes de fonctionnement des produits AB Suite, les
testeurs ont pu charger les fichiers de modeles respectifs
requis par chaque mode.

Documentation utilisateur

Le centre d‘information mis en place dans le test
béta 4 offrait aux utilisateurs un point d‘acces unique,
consultable et centralisé a toute la documentation
essentielle de la version.

Comme toujours, nous apprécions grandement que
nos béta-testeurs prennent le temps de bien tester
AB Suite 7.0 a tous les niveaux. Si vous souhaitez
participer aux prochains tests béta, veuillez nous
contacter a I'adresse ABSuite@unisys.com.
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Le coin des ingénieurs :

Appel de services Web avec WebAppSupport

kS
Par Howard Bell, architecte en charge de I'environnement
d’exécution et de 'outil de débogage MCP EAE/AB Suite, Unisys

Le nouvel Assistant de services Web Linfrastructure supplémentaire prenant en charge I‘Assistant
d‘Agile Business Suite 6.1 vous permet de services Web comprend les classes suivantes :
d‘appeler facilement un service Web * Unisys_WebAppSupportLib : Classe externe configurée
dans l‘application ClearPath MCP qui avec tous les points d‘entrée nécessaires pour le service
encapsule les fonctionnalités utilisées WebAppSupport.

par vos Reports et Ispecs. * Unisys_WebAppSupportHelper : Classe simplifiant les

implémentations de services Web en regroupant les
processus communs de création et d‘appel de services
Web.

* WebAppSupportLibraryBuffers : Contient les tampons
spécialement configurés pour appeler les points d‘entrée

L‘assistant est simple d‘utilisation. Pour créer un service Web
MCP, procédez comme suit :

1. Effectuez un clic droit sur le segment, puis sélectionnez
Add>Add New ltem (Ajouter>Ajouter un nouvel élément).

2. Dans la boite de dialogue « Add New Item » (Ajouter

(. o . WebAppSupport.
un nouvel élément), sélectionnez Web Service>Create PP-UpP
(Services Web>Créer). L'Assistant de services * Unisys_WebAppTypes : Tous les types associés a la
Web s‘affiche. bibliotheque WebAppSupport. >>
3. Entrez un nom pour la classe de votre service Web, puis
cliquez sur « Finish » (Terminer). Dans I'exemple ci- Class View
dessous, le service Web par défaut conserve le nom de Clu|oo|®-
classe par défaut : « WebServicel ». <Search>
¢z . . . 4 SampleDeploy
La classe créée contient la logique et les attributs 4 % Sample
préchargés nécessaires a la mise en ceuvre du service Web. b 7 Base Type
. . Ve - Ve 7 . D Bund'“
Voici le résultat obtenu avec le service météo Unisys. Vous b i Globals
pouvez appeler la méthode a partir d‘une Ispec ou d‘un : ;:’;;Ymms
Report en paramétrant WeatherStnCode avec n‘importe quel & System
code OACI valide pour le tester. Par exemple, vous pouvez 4 2"i3‘¢W°'xP::"P§°"Li':’:'¥|
11z . .. 13 Unisys_WebAppSupportHelper
consulter la météo a Hawaii en choisissant le code « PHNL ». o Unz,_w,bAppSuppom
b *3 Unisys_WebT
1 :Invoke the Weather Service using a valid ICAO code b W':.-Il?:ppS:pp?r::ibrarysuffers
2 WebServicel.WeatherStnCode:= "PHNL" : Hawaii "
3 WebServicel.Invoke() "
a4 @ Invoke()
5 :Output the returned eather data & Latitude
6 message attention WebServicel.WeatherStnCode & Longitude
? message attention WebServicel.LongName & LongName
8 message attention WebServicel.longitude = Rel:umid'
9 message attention WebServicel.latitude -‘ R n ity
10 message attention WebServicel.Temperature .‘ S:,SPO -
9. message attention WebServicel.Skies ._‘ e
12 message attention WebServicel.RelHumidity = Tfmperature
13 message attention WebServicel.Time o Time
' WeatherStnCode
@ WebHelper
008044
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L‘assistant ci-dessus fournit un acceés aux services Web prét a l'emploi depuis votre modele AB Suite.
En outre, il crée toute l'infrastructure nécessaire pour prendre en charge les appels de services Web via
WebAppSupport.

Avec le scénario « WebServicel » illustré ci-dessus, vous disposez maintenant d‘un modele préconfiguré
permettant d‘appeler d‘autres services Web RestFul.

Linterface (signature) de I'exemple de service météo ci-dessus est assez élémentaire. Le codage
LDL+ permettant d‘accéder a des services Web similaires est donc une tache relativement simple.

Par exemple, la logique suivante est suffisante pour appeler le service météo a partir d'un rapport AB Suite :

1 :Invoke the Weather Service using a valid ICAO code

2 WebServicel.WeatherStnCode:= "PHNL" : Hawaii

3 WebServicel.Invoke()

4

5 :output the returned eather data

6 message attention "Station Code = " & WebServicel.WeatherStnCode
7 message attention "Long Name =" & WebServicel.lLongName

8 message attention "Longitude = & WebServicel.longitude

9 message attention "Latitude = " & WebServicel.latitude

10 message attention "Temparature = " & WebServicel.Temperature

Cependant, lorsque l'interface comporte de nombreux arguments, le codage manuel des attributs de classe
AB Suite associés se complexifie un peu. Heureusement, une prochaine version d'AB Suite doit apporter des
améliorations pour prendre en charge la recherche et I'importation des définitions de classes de services Web.

En attendant, vous pouvez vous servir du logiciel Business Integrator pour exécuter cette partie du processus
d‘une autre maniére. Il vous suffit de créer un nouveau composant d‘acces aux services Web. Vous n‘avez
qu‘a fournir les informations nécessaires pour créer la « classe » du service Web.

Voici comment faire.

Créer un composant d‘acces aux services Web

Business Integrator fournit un assistant dont vous pouvez vous servir pour créer une spécification
des composants d‘un service Web. >>

) Fle Action View Window Hebp
= OB RDR @@

() Console Root
= @ Enterprise Apphcation External Components
= B Local
¥ (O [T
8 Depioy, ML
@ % Enterprise Appl Al Tasks *
New Window from Here

In the wizard specify:

*WSDL File Location

*Choose Web Service Method

*Map Web Service Method Parameters — Select NEXT only
*Define Ispec Details — Select NEXT only

L AL LT «Location of the script file — Select NEXT only

© Fle  Action  View
> OB XFR @B @ + X 'YV e » x
) Corsole Root | [p——
Erterprme Apphatan External Component
-4 viom o * |[remname  Testnpe Tien... | Cec....
= (™) Component Specifications RESILT Signed 10 2
N e WSFALLTACT  Alphs % 0
4 Deployed Components WSFALLTCCO  Alpha 20 o
% Apphcation € J Components HUB WSFALLTOET  Alphs 7 o
WSFALLTSTR  Alha 7% 0
%0003 Sigred w2
Y0004 Sigred w2
< >
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Pour créer la spécification, procédez comme suit :

1. Effectuez un clic droit sur le nceud « Component
Specifications » (Spécifications des composants).

2. Sélectionnez New>Web Service Access Component
(Nouveau>Composant d‘acces aux services Web).
Un assistant s‘affiche.

3. Indiquez les informations nécessaires et suivez toutes
les pages de I‘assistant.

4. Suivez les étapes ci-dessus pour créer un fichier
.Model, avec Action>Extract (Action>Extraire). Ensuite,
sélectionnez le type .Model pour AB Suite dans « Save
as Type » (Enregistrer sous Type).

Fichier .Model

Exporter la

spécification Définitions

Ispec

Créer une
spécification

Business
Integrator
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Aprés avoir effectué ces étapes, accédez a AB Suite,
importez le modéle et donnez-lui le nom du segment
« NOUVEAU PROPRIETAIRE ».

Fichier .Model

o Importer
Définitions
Ispec

Importer un modele

System Modeler
d'AB Suite

Comme illustré ci-dessus, nous obtenons une Ispec

avec la structure, la disposition et le format du service
Web requis. Mais comme seule la classe de I'Ispec

est utilisée pour la définition des attributs d‘appel des
services Web, il est possible de supprimer le stéréotype.
[l est maintenant possible de modifier cette nouvelle
classe « Web Service » (service Web) afin d‘inclure une
méthode INVOKE qui appelle les différentes méthodes
WebHelper (suivant la méme approche et le méme ordre
que le scénario « Service Web1 » ci-dessus) et renvoie les
résultats de I'appel dans ses attributs locaux. Notez que
le nom de la « méthode INVOKE » a été choisi de facon

a rester cohérent avec la structure fournie par I'assistant.

A proprement parler, WebAppSupport prend en charge les
services Web RESTful. Toutefois, cela ne vous empéche
pas de vous en servir pour appeler les services Web SOAP.
Pour ce faire, il vous suffira de fournir une logique LDL+
supplémentaire pour créer la requéte XML sous forme de
requéte SOAP, puis d‘analyser la réponse XML SOAP.

Veuillez noter que I'analyseur XML de ClearPath MCP doit
étre installé et configuré sur le systéme MCP héte pour
appeler les services Web. Pour en savoir plus, reportez-
vous a la documentation WebAppSupport sur le site du
support Unisys.
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Microsoft Azure et VSTS : Apercu pratique

d‘Agile Business Suite

Par Rob Henrichs, spécialiste informatique, Unisys

Remarque : Cet article présente quelques-unes des observations que nous avons faites dans le cadre d‘un projet de validation
de principe réalisé a l'aide d'un modeéle d‘implémentation non pris en charge actuellement et ne pouvant pas étre utilisé avec la
version actuelle d’AB Suite. Bien que nous soyons en train de chercher comment prendre en charge votre utilisation d’AB Suite
avec ces fonctionnalités, Unisys ne garantit ni la date ni I'éventualité du lancement d’une version commerciale finale du produit
prenant en charge le modéle d'implantation dont il est fait mention ici. Unisys ne se prononce pas non plus quant a l'utilisation
d‘un environnement de cloud, et il appartient a vous et/ou a votre entreprise de décider si l'utilisation d‘un environnement

de développement axé sur le cloud vous convient, selon les exigences, les politiques et le contexte (notamment juridique et
réglementaire) auxquels votre utilisation est soumise.

A I'heure actuelle, il est trés courant de travailler dans le cloud. Et comme de nombreux
clients d'Agile Business Suite ont demandé comment ils pourraient développer dans

le cloud, nous avons décidé d‘étudier les possibilités d‘utiliser Microsoft Azure et
Microsoft Visual Studio® Team Services (VSTS) avec AB Suite Developer et AB Suite
Runtime pour Microsoft Windows.

Azure est un service cloud permettant de créer, de tester et de déployer des applications via un réseau de centres
informatiques gérés par Microsoft. Comme les applications AB Suite sont développées a l‘aide d‘outils Microsoft et peuvent
étre utilisées dans un environnement d‘exécution Windows, les tests dans le cloud Azure étaient parfaitement adaptés.

En fait, une VM Azure Windows est accessible via une connexion RDP, comme toutes les autres VM. Elle est simplement
située dans le cloud Azure.

Créer une VM Crootevirtua mactine

La création d'une VM dans le 1 e | -

tableau de bord Azure est un R

processus simple et guidé par 2 i | -

un assistant. Vous commencez N :
par définir les propriétés e il e

principales et sélectionner | i 2 2R O
la quantité de processeurs, Sl T e we W T W s
de mémoire et d'espace disque e Do e e e e e
dont vous souhaitez disposer. s S w e me wm w v e
Ensuite, votre VM est == o] [ B ® B Ome o e e
automatiquement provisionnée. >> N L e . .
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Aprés avoir créé la VM, le tableau de bord vous propose

des options pour la démarrer, l‘arréter et vous y connecter.
Sélectionnez le bouton « connect » (connecter) afin d‘obtenir
un lien RDP pour vous connecter a la VM exactement comme
vous le feriez avec tout autre serveur utilisant un client RDP.

Ajouter AB Suite a la VM

La facon la plus simple d‘installer le logiciel AB Suite requis
sur la VM est d‘utiliser l‘option de connexion des lecteurs
locaux dans le client Windows RDP. Ou encore, vous pouvez
télécharger le logiciel avec un compte de stockage Azure.
Ensuite, vous pouvez vous connecter au stockage a l‘aide
d‘un disque mis en correspondance.

Une fois que le logiciel nécessaire est copié dans la VM,
il vous suffit d‘installer AB Suite comme vous le feriez
normalement.

Tester la VM

Nous avons testé ce processus en installant

AB Suite 6.1 Developer et Windows Runtime dans une
VM Azure. La VM Azure que nous avons créée pour le test
a été configurée avec 2 vCPU, 16 Go de mémoire et 130
Go d‘espace disque.

Nous avons effectué une installation locale, avec tous les
logiciels Microsoft SQL Server®, Visual Studio et AB Suite
nécessaires sur le méme serveur. Le processus d‘installation
a été trés simple et rapide.

Parmi les principales raisons de tester AB Suite
Developer avec Azure, il était question de voir
comment la solution fonctionnerait avec le service
Microsoft Team Foundation Server (TFS) basé dans
le cloud et disponible dans VSTS.

Pour tester cela, nous nous sommes servis d‘un exemple

de modele que nous avions déja chargé dans VSTS (image
suivante), puis nous nous sommes connectés a VSTS depuis
la VM Azure. Ainsi, nous avons pu créer automatiquement
une base de données locale de Modeles dans l'espace

de travail VSTS local, puis nous en servir pour tester le
débogage sur une base SQL Server locale et contréler

les modifications apportées a VSTS.
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En utilisant VSTS de cette facon, il est possible de créer et
de partager plusieurs VM Azure entre développeurs, un peu
comme avec les machines locales et TFS.

Outre l'utilisation de l‘outil de débogage, nous avons
également étudié la possibilité de déployer une suite AB
locale sur I'environnement d‘exécution Windows dans la
méme VM Azure que le logiciel AB Suite Developer. Tout s‘est
passé comme prévu, car le processus est pratiguement le
méme que celui de la création sur une machine locale. Pour
tester 'acces, nous nous sommes connectés au systéme
déployé via un client WinForm local. >>
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Comment démarrer ?

Il est treés simple de créer et de configurer une VM Azure

pour l‘utiliser avec AB Suite Developer. La procédure est tres
similaire a la configuration d‘un ordinateur portable, d'un PC
ou d‘un environnement VM indépendant. La seule véritable
difficulté consiste a récupérer les fichiers nécessaires sur la
VM, par exemple le support d‘installation. Apres avoir effectué
cette étape, I'utilisation de VSTS simplifie la mise en place
des environnements de développement sans avoir besoin
d'investir dans du matériel local.

La VM Azure se comporte comme n‘importe quel autre
serveur VM, sans exigences particulieres pour AB Suite.
Lorsque I‘on utilise une VM Azure comme environnement
autonome de développement et de test, il est nécessaire de
prévoir un contrle de version, et VSTS est de loin la méthode
la plus simple. Finalement, il s‘agit de TFS dans le cloud.

Pour commencer a utiliser VSTS, vous avez d‘abord besoin
d‘un compte Microsoft. Si vous n‘en avez pas déja un, vous
pouvez créer un compte VSTS ici.

Aprés la création d'un compte et votre premiére connexion, une
interface Web trés similaire a celle utilisée dans TFS s‘affiche.

team backlog to pick up e o

e
osito

Continuously integrate Backiog

Automate your builds Board
-I |I 1 Visualize progress ks

Al Learn how to add charts
Sprint Burndown New Work ltem
ter it

Set iteration dates to use the sprint
burndown widget o V

Set iteration dates

Pour vous connecter dans Visual Studio, accédez a l‘option
« Manage Connections » (Gérer les connexions) dans
Team Explorer, puis entrez I'URL du VSTS créé. Ou encore,
si vous étes sur le méme serveur, utilisez le lien depuis
I'interface Web.

Select s Team Foundstion Server:

Team Project Collct

oo TP Cateions | |

e [T ]

ol ]

- Team Biplorer
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Ensuite, un nom est demandé a l‘ouverture de la solution
dans TFS et AB Suite pour nommer la base de données de
modeles a utiliser, comme lors de la connexion a TFS.

Yes 2822018171
Ve 2822018171

=D  Application Project Wizard
£ ] oo 1o Atton et s oS oot

D steps Project reation conf fimation
Model

Confimation

Prog intrface development with model name Rep, Sample VSTS on server NL-
HENRICHR in  database Rep_Sample.VSTS' fo the exisig project
Results

Une fois cette étape terminée, vous étes prét a commencer
a utiliser le contrdle a la source VSTS, notamment avec les
fonctions Checkout et Checkin, comme vous le feriez dans TFS.

CASH.Construct # X
FDolhen (G _WORK.G_ISPEC = “CASH"}

: Return from NINQ
Move G_WORK.G_ORDINATE CUSTOMER
LookUp CUSTOMER Cust

Check Out ? X

Files:

Name Folder

[l SAMPLE_CAS... C:\Users\RobH.ABSNL1 \Source\Workspaces\MyFirstProject\Rep_Sample_V5...

Lock type: | Check Out - Prevent other users from checking out and checking in

Team Explorer - Pending Changes =
© @ ¥ | & | Search Work ftems (Ctri+) A - | show output from:  Source Control - Team Foundation -

omatically checked out for ed:
omatically checked out for editing.
omatically checked out for editing.

Pending Changes | MyFirstProject &/ ‘W

@ Changeset 18 successfully checked in. x

Shelve | Actions =

4 Related Work Items
Queries v | Add Work [tem by ID =

Drag work items here to link them to the check-in.
4 Included Changes

Exclude All | View Options v

There are ne pending changes

4 Excluded Changes

Include Al | View Options +

There are no pending changes.

Si vous souhaitez découvrir la puissante association entre
AB Suite et VSTS dans votre propre environnement de
développement, ou en savoir plus sur les fonctionnalités
décrites dans cet article, nous vous invitons a nous
contacter par e-mail a l'adresse ABSuite@unisys.com.
Nous nous ferons un plaisir de vous aider !
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Perfectionnement des compétences

avec les services de formation AB Suite

Que vous soyez un ancien utilisateur d‘EAE qui
découvre I'environnement Agile Business Suite ou
un expert de longue date d'AB Suite, une chose est
certaine : il n‘est jamais trop t6t ni trop tard pour
perfectionner ses compétences.

Dans cette optique, Unisys propose un certain nombre

de cours de formation dans le cadre de son offre de

services de formation AB Suite. Bien que nous ayons créé

un programme de formation fiable et cohérent, vous pouvez
tout a fait adapter ce matériel de cours aux besoins et aux
compétences spécifiques de votre organisation, et nous vous
encourageons a le faire.

Veuillez noter qu‘il est fortement recommandé de bien
connaitre Visual Studio, car I'environnement de développement
AB Suite fonctionne comme un plug-in de Microsoft Studio IDE.
Il existe de nombreuses ressources en ligne permettant a votre
équipe de perfectionner sa maitrise de Visual Studio, ainsi que
des formations provenant de différentes sources.

Pour apprendre les bases du développement d'’AB Suite, voici les
cours qui en constituent le programme de formation de base.

Agile Business Suite Developer pour les
utilisateurs d‘EAE (CEL8022)

Ce cours s‘adresse au personnel technique chargé de
développer des applications dans AB Suite. Bien que

nous ayons élaboré des supports de cours destinés tout
particulierement aux clients qui migrent vers AB Suite depuis
EAE, les personnes sans expérience d’utilisation d’EAE
peuvent tout a fait prendre part a la formation malgré le titre
mentionnant « pour les utilisateurs d‘EAE ».

Dans ce cours, nous formons de plus en plus d'utilisateurs
peu familiarisés avec le développement piloté par modele, aux
cotés de ceux qui ont une grande expérience d'EAE. En fait, la
mixité dans une classe renforce généralement la productivité
et I'intensité de la formation telle gu‘elle est vécue. C'est

une excellente occasion pour renforcer les compétences

en développement d‘applications de votre équipe, tout
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en augmentant la synergie parmi tout votre personnel de
développement.

Ce cours dure généralement quatre jours.

Maintenance et amélioration des applications
AB Suite (CEL8031)

Ce cours s‘adresse au personnel technique déja habitué a
utiliser AB Suite en situation réelle dans ses propres processus
de développement.

Ce cours assuré par un formateur propose des conseils
supplémentaires et des recommandations sur les meilleures
pratiques en matiere de création de modeles dans

System Modeler et de création d‘applications AB Suite.

Vous apprendrez les différents concepts et taches liés au
développement d‘applications a l‘aide d'AB Suite et de

ses environnements connexes, ainsi que les concepts de
modélisation.

Ce cours met également l'accent sur l‘interaction entre
I'‘étudiant et le formateur, en particulier sur I'expérience des
étudiants avec AB Suite jusqu‘a présent. Nous organisons
également des séances de mentorat avec les participants,
afin qu'ils puissent clarifier tous les points de confusion ou de
préoccupation et obtenir de plus amples renseignements sur
différents sujets.

Ce cours dure généralement entre huit et dix jours, selon le
niveau d‘expérience des participants et les besoins spécifiques
que vous souhaitez aborder.

Utilisation du contrble a |la source de Team
Foundation Server (TFS) avec AB Suite (CEL8034)

Ce cours assuré par un formateur vise le personnel technique
chargé du développement et de la gestion des versions, et
disposant déja d‘une certaine expérience d‘AB Suite. Bien que
le cours porte principalement sur |‘utilisation de TFS pour le
contréle a la source, nous abordons également l‘utilisation de
TFS pour les opérations de compilation et de test. >>
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De plus, nous proposons des formations sur
I'installation, la configuration et I'implémentation de
TFS dans l'environnement de développement AB Suite
par I'intermédiaire d‘une combinaison de cours,
d‘exercices et de présentations préenregistrées.

Ce cours dure généralement trois jours et demi.

Ces cours de base ne sont qu‘un petit apercu du riche
contenu de formation AB Suite que nous offrons. Pour
savoir comment adapter un plan de formation AB Suite
aux besoins de votre organisation, veuillez contacter
votre représentant Unisys ou nous envoyer un e-mail

a l'adresse ABSuite@unisys.com.
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Voici quelques-uns des ajouts récents aux bibliotheques de guides pratiques, de livres blancs et autres
informations utiles :

* Guide pratique : Comment mettre a niveau d'AB Suite 4.0/5.0 vers AB Suite 6.1 des modeles avec le contrdle

a la source (NOUVEAUTE)

* Guide pratique : Configurer des pare-feux pour AB Suite Windows Runtime en réseau (Mise a jour)
* Matrices de qualification et de support des logiciels : AB Suite 5.0 (Mise a jour)
* Matrices de qualification et de support des logiciels : AB Suite 6.1 (Mise a jour)

Pour y accéder, ainsi qu'a d'autres ressources, il vous
suffit de vous connecter au site public.support.unisys.
com et de sélectionner « Documentation » dans la section
« Public Information » située sur le c6té gauche de
I'écran. Aucun identifiant particulier n’est nécessaire.

De plus, plusieurs de nos livres blancs qui font office
de référence sont disponibles sur la page d’accueil
d’AB Suite :

e AB Suite in the Application Lifecycle
e Adile Development with Agile Business Suite

e Unisys Agile Business Suite: Capitalize on Change,
Don’t React to It

Nous vous encourageons également a consulter la
liste des formations AB Suite disponibles. Combinant
des sessions assurées par un instructeur et de
formations en ligne, ces ressources pédagogiques de
premier plan comprennent de nombreux graphiques,
activités interactives, simulations et démonstrations,
accompagnés d’explications orales.

Pour vous tenir au courant de toute I'actualité concernant
ClearPath Forward, abonnez-vous a la lettre d’information
ClearPath Forward Connection et lisez le numéro

d‘aolt 2018.

Nous vous invitons également a vous familiariser avec
notre portefeuille de services ClearPath Forward Services
en visitant notre site Web et en consultant notre brochure.

Si vous voulez explorer AB Suite sous forme d‘évaluation,
veuillez télécharger AB Suite Express aujourd’hui !

Cette offre gratuite inclut le package AB Suite complet
(AB Suite Developer et AB Suite pour Windows Runtime),
ainsi qu’un cours de familiarisation pour vous permettre
de découvrir I'essentiel d’AB Suite en un clin d’ceil.

Les spécifications sont susceptibles d‘étre modifiées sans préavis. Aucune garantie
de quelgue nature gue ce soit ne sapplique a ce document. Unisys décline toute
responsabilité financiere ou autre découlant de I'utilisation des informations
contenues dans ce document, y compris les dommages directs, indirects ou spéciaux.
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